
Computer assisted 
telephone interviewing 
(CATI): Resource Pack
This resource pack provides practical guidance on how to use CATI within
SurveyCTO. The pack was developed in collaboration with SurveyCTO and
is based on their own Basic CATI Starter Kit.

The aim of the resource pack is to provide a step-by-step walk-through for
using  CATI,  applying  an  approach  that  is  already  contextualized  for
international  development  and  humanitarian  work.  This  resource  pack
assumes some prior knowledge of using SurveyCTO.

It should be noted that SurveyCTO provides two options for using CATI: case
management  or  non-case  management  (see  Additional  information for
further  details).  Based  on  experiences  when  piloting  the  software,  this
resource pack follows Oxfam’s preferred approach, non-case management.
More  advanced  features  are  also  available  when  using  SurveyCTO’s
Advanced CATI  workflow, but  these are not  included within  this resource
pack.

What do i need to get started?

The following resources are required in order to use the system:

Required Resources: Desirable Resources:

 SurveyCTO subscription1

 Knowledge of SurveyCTO (form 
building, user management and 
data collection)

 Phone numbers of the people 
you want to interview

 Your data collection tool (survey)
in Excel format (XLS)

 Smart phone handsets

 Headsets/headphones

1 Details incl. costings can be found here:  https://www.surveycto.com/

 Phone coverage/airtime budget

A note on XLS forms: This resource pack assumes familiarity with XLS 
form building, which means the ability to build your surveys using an Excel 
form, rather than SurveyCTO’s online form builder. 

How do I set up CATI?

Broadly speaking, there are five steps (with a sixth optional step) to setting
up CATI on SurveyCTO. The resource pack will  talk you through each of
these. 

Step 1: Integrating CATI into your data collection tool   (survey)  
Step 2: Preparing the call list 
Step 3: Uploading to SurveyCTO
Step 4: Setting up your data-collection device (mobile phone)
Step 5: Training your data-collection team
Step 6: Setting up the dashboard (optional)

Additional information

At the end of the annex you can find additional information on the following 
topics:

 Audio   a  udit  s  
 Case management vs. non-case-management  
 Encryption  
 Further support  

https://www.surveycto.com/


Step 1: Integrating CATI into your data
collection tool

1.1 Download and open the CATI Survey Template (Excel). Click to
enable editing. 

1.2 Go to the  Settings tab. Enter a form title and ID into the blank
cells highlighted in yellow.

Important Notes:
 Your form ID cannot contain spaces, instead you should

replace these with underscores e.g. Phone_survey_PDM

1.3 Open  your  data  collection  tool  (e.g.  Household  Survey,  Post
Distribution Monitoring tool) in XLS format.

1.4 You must now copy and paste your survey into the CATI Survey
Template (Tab 1: survey).  These must be copied and pasted
into the blank space between Row 46 and Row 68.

Important Notes:
 In order to do this, you can add or remove as many rows as

you need.
 You should copy and paste all the data, including data under

columns  such  as  Relevance,  Constraints,  etc.  If  you  are
copying  and  pasting  an  entire  row,  ensure  that  the  Excel
column headings in both sheets are in the same order.

 Meta data,  consent and closing/thanking notes are already
included in the template, you therefore do not need to copy
these. Do not attempt remove those already contained within
the form as they are linked to wider form functionalities. 

1.5 You must now repeat this process for your choice lists (answer
options). 

Copy and paste your choice lists from your data collection tool
into the CATI Survey Template (Tab 2: choices)

Important Notes:
 Do  not  delete choice  lists  already  within  the  template.

However, some choices (e.g. yesno) are already included in
the form, so you may need to delete any duplicates if these
are also included in your own choice lists. 

1.6 Edit the consent section as per your needs and requirement. To 
do this, you should replace the data in cell C41 with the consent 
question that has been contextualized for your data collection.

Important Notes:
 For  more  details  on  capturing  informed  consent,  visit

Oxfam’s  responsible  Data  Management  Training  Pack2

and the fifth paper of the Going Digital series3

 The  answer  options  to  consent  question  are  already
contained in the form and should not edited. The answer
options are as follows:

o Consents to complete the survey now
o Consents to complete the survey, but not now
o Does not consent to complete the survey 

2 https://policy-practice.oxfam.org.uk/publications/responsible-data-management-training-pack-
620235 

3 https://policy-practice.oxfam.org/resources/going-digital-privacy-and-data-security-under-gdpr-
for-quantitative-impact-eval-620884/

https://policy-practice.oxfam.org/resources/going-digital-privacy-and-data-security-under-gdpr-for-quantitative-impact-eval-620884/
https://policy-practice.oxfam.org/resources/going-digital-privacy-and-data-security-under-gdpr-for-quantitative-impact-eval-620884/
https://policy-practice.oxfam.org.uk/publications/responsible-data-management-training-pack-620235
https://policy-practice.oxfam.org.uk/publications/responsible-data-management-training-pack-620235


1.7 You can set a maximum number of call attempts for CATI. For
example, if a total  X number of calls are made to a respondent
with  no  answer,  no  further  attempts  can  be  made,  and  the
interviewee will be automatically removed from the call list. 

As default, this is set to  3 calls. To increase/decrease this, you
need to edit the information in the calculation column of Row 30
‘stop_at’  (Cell  Q30).  For  example,  if  you  wish  to  have  a
maximum of 5 calls, this should be changed from int(3) to  int(5).

1.8 Save a copy of the form and proceed to Step 2. 



Step 2: Preparing the call list
Before you begin… This is where you will  be entering the details of your
interviewees.  You will  therefore need to  have contact  details  (e.g.  phone
numbers) of your interviewees before completing this step.

2.1 Download and open the Respondents Template Excel file. Click
to enable editing.

Important Notes:
 Alongside  the  template,  there  is  a  filled  example  of  a

prepared  call  list  available  in  the  resource  folder
Respondents Example (Filled in)

2.2 Fill in the Excel file with the details of your interviewees. The table

below
 provides guidance on the information that should be entered into
each column.

2.3 Once you have added all  the details of your interviewees, you
need to save the file.

Important Notes:
 If the list is very long, it is recommended you save the file

as a CSV as it will upload faster.

respondents
_details

id_key users resp_pn full_name address num_calls callback_tim
e

last_call_stat
us

needs_revie
w

now_complet
e

This column 
contains a 
formula and 
will auto-
populate 
when other 
cells are 
filled in. 

Once you 
have added 
your data, 
drag this 
column 
down to 
apply the 
formula to all
of your rows.

Each 
interviewee 
should be 
given a 
unique 
numerical ID 
key. It is 
recommende
d that for 
ease, you 
start this 
number at 1 
and increase 
by 1 each 
time 

This column 
is used to 
assign calls to
each of your 
interviewers.

To do this, 
you must fill 
this column 
with the 
username of 
the 
interviewer to 
whom you 
want to 
assign the 
call. The 
username will
have been 
assigned to 
them when 
you added 
them as a 
user to 
SurveyCTO.

Enter the 
phone 
number of the
interviewee.   
Note: The 
phone 
number will 
appear 
identically in 
the dialler. 
Therefore, if 
you require 
country dial 
codes to 
make the call,
ensure these 
are included 
within the 
Excel file.

Enter the 
name of the 
interviewee.

This can 
contain 
information 
about the 
location of the
interviewee. 
For privacy 
reasons, it is 
recommende
d that you do 
not enter a 
specific 
address, but 
rather the 
Governorate, 
District or 
Sub-District 
where the 
interview 
resides. 

Set to ‘0’ No action 
required: 
leave this cell 
blank

No action 
required: 
leave this cell 
blank

No action 
required: 
leave this cell 
blank

This cell must 
always 
contain ‘No’

Step 3: Uploading to SurveyCTO



Before you begin… In order to be able to deploy your form design and the
respondents list  in  a server dataset, you'll  need to be logged in with a
user with appropriate permissions.4

3.
1

Download the following zip files from the Resource Pack:

 Phone Call Plug In: 
https://github.com/surveycto/phone-call/raw/master/phone-
call.fieldplugin.zip

 Table Plug In: 
https://github.com/surveycto/table-list/raw/master/table-
list.fieldplugin.zip

3.
2

Log into SurveyCTO and open the Design tab.

3.
3

Create  a  group.  This  is  where  you  will  upload  the  XLS  and
Excel/CSV file you developed in Step 1 and Step 2. 

Within the group,  click  the button  Add a form, dataset or  sub-
group

Click Upload Form Definition and select the Excel file you created

4 https://docs.surveycto.com/04-monitoring-and-management/01-the-basics/
00b.managing-user-roles.html

in Step 1 (CATI Survey Template).

When uploading,  attach the plug ins (Phone Call and Table)  as
annexes. These should be uploaded as zip files. Do not extract the
content. 

Click Upload.

3.
4

In the same group as your XLS file, you need to create a dataset.
To do this, click the ‘+’ button and then Add server dataset. When
you click this, the dataset will default to New dataset for data. Do
not amend this. 

https://github.com/surveycto/table-list/raw/master/table-list.fieldplugin.zip
https://github.com/surveycto/table-list/raw/master/table-list.fieldplugin.zip
https://github.com/surveycto/phone-call/raw/master/phone-call.fieldplugin.zip
https://github.com/surveycto/phone-call/raw/master/phone-call.fieldplugin.zip
https://docs.surveycto.com/04-monitoring-and-management/01-the-basics/00b.managing-user-roles.html
https://docs.surveycto.com/04-monitoring-and-management/01-the-basics/00b.managing-user-roles.html


The dataset  title  and ID should  be set  to  ‘respondents’.  If  you
already  have  dataset  called  ‘respondents’  located  within  your
server, please follow the instructions in the box on the next page. 

You then need to select the Excel or CSV file you prepared in Step
2 and click  Create dataset. Once the dataset is created, you will
see the  Data Preview box (preview on next page) on the screen.
Select Keep it.



3.
5

Your created dataset will now appear within the group. 

Click Publish into which appears on the right of the dataset name,
followed by Add a form. 

Select your data collection tool that you uploaded in Step 3.3. 

3.
6

Click the Add button under the form name, and then fill out the field
mapping table so that it matches the table on the next page.

In order to complete the mapping, add a line and then select the
correct field in the text box on the left hand side. The text box on the
right  will  automatically  populate  with  the  same content.  In  some
cases, you will therefore need to delete the contents of the text box
and change it using the drop-down menu. 

ALREADY HAVE A DATASET CALLED ‘RESPONDENTS’?

If you already have a dataset called respondents within your server, 
for example from a previous set of interviews, you will not be able to
create a second. Instead, you can call the dataset another name, for
example: respondents2. If you do this, you will also need to make 
some small edits to the data collection tool you developed in Step 1.

To do this, open your data collection tool. In column N, you will have
your calculation functions. Currently, these are set to instruct 
SurveyCTO to pull data from the dataset called respondents.

To change these, highlight Column N and then select Find and 
Select > Replace



3.
7

Select  Id  in  the  Form field  to  identify  unique  records.  Leave
everything else blank and click save.

3.
8

Select  the  Attach  option,  which appears on the dataset  (next  to
publish into).

3.
9

Find and select the survey you created in Step 3.3 and then click
Close.

Important Notes: 
 Your table will appear empty unless calls are assigned to

your  username  under  the  ‘users’  column  of  your
respondents file. 

Step 4: Setting up your data collection
device 
Choosing the right settings 

In order for the case list to update after each call/call attempt is completed,
you will need to activate certain settings within your SurveyCTO Collect App.
To access settings, open the App and click the three dots in the right hand of
the corner, followed by General Settings.

Once you have opened  General Settings, you should select the following
options. These will  ensure that the call list  is able to update automatically
with the outcomes of each call attempt:

 Auto send with Wi-fi5  
 Auto download with Wi-Fi6 
 Auto download on demand

To ensure the ‘call  list’  data  is  stored safely  on the device,  the following
Admin Settings  should be activated. To access this, click the same three
dots shown in the image above, followed by Admin Settings. 

 Admin Password:  Set  a password to lock admin settings on the
device before distributing to the data collection team

 App Passcode: This will ensure that a password is needed in order
to open the SurveyCTO collect app.

Finally, it is recommended that you open your mobile phone in landscape (by
turning on the phone’s auto-rotate function); you might not be able to see all
of the call list table in portrait mode on smaller screens.

The forms and device should now be working! You should now test them!

Step 5: Training your data-collection 
team

5 If you are not using Wi-Fi, but instead mobile data/network, select Auto 
send with Network instead.
6 If you are not using Wi-Fi, but instead mobile data/network, select Auto 
download with Network instead.



As with any data collection, particularly when using new approaches or 
softwares, detailed training should be carried out with the data-collection 
team to ensure safety and effectiveness. 

The annexed training materials and example protocol can be used as 
guidance for this.



Step 6: Setting up the dashboard 
(optional)
Before you begin… The steps below are guidance for  setting up a basic
dashboard using MS Excel. However, you can adapt and edit this depending
on the data you wish to show. You do not need to have a dashboard in order
to use CATI, however, it will make the monitoring process easier. 

6.1 In order to set up the dashboard, you should first make a second
dataset  that  holds  all  the  data  which  you  would  like  to  have
visualized within the dashboard.

To do this, log into SurveyCTO and click on the Design tab.

Locate  the  group  that  contains  your  data  collection  tool  and
respondent dataset and click to Add Server Dataset. The dataset
will default to New dataset for data, do not change this.

You  can  call  the  dataset  any  name  you  like.  We  recommend
dashboard data (ID: dashboard_data_projectname).

You can then click Create Dataset. Do not select any files to upload.

6.2 On the dataset, then click Publish into followed by Add a form. You
should select your data collection tool (surveyl).

You should then add the following fields to the field mapping. You can

always add more fields, depending on the data you want to include in
your  dashboard.  However,  you  should  never  include  personal  or
sensitive data in the field mapping – these are not appropriate fields
to be included in dashboards.

Once you  have  completed  the  mapping,  leave  the  following  fields
blank:  Form field  to  identify  unique  records  and  Include  form
submissions whenever the field is 1. 

Tick the box that says Publish existing data

6.3 The next step is to link the data from this dataset into your dashboard.

Open a new, blank Excel file.
In one worksheet, you need to click  Data in the tool bar followed by
Get data from Web



To  make  the  connection  to  your  dataset  you  will  use  a  URL
constructed as the example below:

https://SERVERNAME.surveycto.com/api/v2/datasets/dat
a/csv/YOURDATASETNAME

For example: 

https://oxfamdemo.surveycto.com/api/v2/datasets/data/csv/dashboard
_data

6.4 If this is the first time linking the data to Excel, you will need to provide
your SurveyCTO credentials.

Click  on  Basic and  then  enter  your  SurveyCTO  Username and
Password

You will then be presented with a preview of your data. Click Load.

6.5 While  you  can  manually  refresh  your  data  by  simply  pressing  the
Refresh button, you can also set the data to automatically update.
Click Refresh All followed by Connection Properties 

You  can  then  select  whether  you  want  the  data  to  refresh
automatically at time intervals, or as a minimum, each time it the file is
opened.

6.6 Once your data are imported and set to refresh, you create a second
tab in the Excel file. You can then create your dashboard using tables
and graphs. 



7. Additional information

7.1 Audio audits

The audio audit functionality is not included in the resource pack templates.
Therefore, you will not be able to listen back to any of your interviews when
exporting the data. You can find information on how to add the audio audit in
SurveyCTO’s documentation.

7.2 Case management vs non-case-
management

SurveyCTO provides two approaches to using their Basic CATI Starter Kit:
one  using  the  case  management  functionality7 and  the  other  not.  The
templates  provided  in  this  resource  pack  are  built  from  the  non-case-
management approach

7.3 Encryption 

If you are planning on encrypting your data, you will need to make sure that
some fields are ‘publishable’ so that the respondent data can still be pushed
through and appear on the call list. In order to do this, you should ensure that
‘yes’ is written in the publishable column for the following fields in your data
collection tool:

name publishab
le

username yes
caseid yes
phone_call_duration yes
users yes
pub_to_users yes
callback_time yes
new_sortby yes
call_num yes
needs_review yes

7 You can find more information about the two approaches, and the differences between them 
here:  https://docs.surveycto.com/03-collecting-data/03-data-collection-workflow/02.case-
management.html

now_complete yes

phone_response_sh
ort

yes

Important Notes: 
 For  privacy  and  security  reasons,  do  not  make  fields  containing

personal or potentially sensitive data publishable.

7.4 Further support 

If you have any questions on using CATI within SurveyCTO, you can visit
their SurveyCTO Support Centre.8,9

8 https://docs.surveycto.com/02-designing-forms/01-core-concepts/03ze.field-types-audio-
audit.html
9 https://support.surveycto.com/hc/en-us

https://support.surveycto.com/hc/en-us
https://docs.surveycto.com/02-designing-forms/01-core-concepts/03ze.field-types-audio-audit.html
https://docs.surveycto.com/02-designing-forms/01-core-concepts/03ze.field-types-audio-audit.html
https://docs.surveycto.com/03-collecting-data/03-data-collection-workflow/02.case-management.html
https://docs.surveycto.com/03-collecting-data/03-data-collection-workflow/02.case-management.html
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